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About This Guide

This guide, Successful WebEx Meetings, provides tips and techniques that you can use 
to conduct more effective meetings on the Web. However, this guide does not 
provide detailed instructions for using your meeting service.

To obtain detailed instructions on using the options and features that this guide 
describes, refer to the online Help on your meeting service Web site.

Many of the tips and techniques in this guide were provided by meeting service 
users like yourself. If you have a tip that you want to share with other users, please 
send a detailed description of your tip to docs@webex.com.

Obtaining Assistance

WebEx provides comprehensive technical support to its customers. To receive 
technical support for your meeting service, do one of the following:

! For urgent issues, call 408-435-7088 or 1-866-229-3239, 24 hours a day, 7 days 
a week.

! For non-urgent issues, send an email message to support@webex.com.

The Support page on your meeting service Web site also provides support 
information, such as frequently asked questions (FAQs) and release notes. 
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Providing Feedback to WebEx

At WebEx, we value your comments about our software products and 
documentation. 

Providing Feedback About Your Meeting Service

To provide feedback about your meeting service, you can use the WebEx feedback 
form, which appears automatically at the conclusion of your meetings and is 
available on your site’s Support page. Or, you can send an email message to 
feedback@webex.com.

Providing Feedback About This Guide

If you have comments about this guide or other WebEx documentation, please send 
an email message to docs@webex.com. In your email message, please specify the 
section to which your comment applies. If you would like to receive a response to 
your comments, please include your name and contact information in your 
message. 
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Setting Up a Meeting

This section provides information for meeting hosts, including tips and techniques 
for scheduling a meeting and setting up a teleconference.

Choosing the Right Level of Security

You provide security for your meeting by doing any of the following on the Schedule 
a Meeting page:

! Require a password: Most meeting service Web sites require that you specify a 
password for any meeting that you host. Attendees must provide this password 
to join the meeting. 

On the Schedule a Meeting page, type a password in the Set meeting password 
and Confirm password boxes.

! Schedule an unlisted meeting—An unlisted meeting does not appear in the 
list of meetings on your organization's meeting service Web site. To join an 
unlisted meeting, attendees must click the Unlisted link under Attend a 
Meeting on the navigation bar, then provide a unique meeting key. 

On the Schedule a Meeting page, select Unlisted meeting.

! Exclude the meeting password from email invitations—If you have specified 
a meeting password, you can prevent the password from appearing in the email 
invitations that your meeting service Web site automatically sends to attendees. 

On the Schedule a Meeting page, click Edit Options, then select Exclude 
password from email invitations.
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! Require attendees to log in—You can require that attendees have a user 
account on your meeting service Web site. Thus, attendees must log in to your 
site before they can attend the meeting. 

On the Schedule a Meeting page, click Edit Options, then select Require user 
account: Attendees must log in to Web site before joining the meeting.

The level of security that you choose depends on the meeting's purpose. For 
example, if you schedule a meeting to discuss your company picnic, you probably 
need to specify only a simple password for the meeting. On the other hand, if you 
schedule a meeting in which you will discuss sensitive financial information, you 
may want to specify that the meeting is unlisted.

Note Once you start a meeting, you can provide additional security by “locking” the 
meeting. For details, see “Preventing Unauthorized Access to a Meeting in Progress” 
on page 13.

Scheduling a Recurring Meeting

If you want to host a meeting on a regular basis, you can specify one of the following 
recurrence patterns when scheduling a meeting:

! daily recurrence

! weekly recurrence

! constant
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If you specify a constant meeting, the meeting remains on your personal meeting 
calendar until a date that you specify, or you delete it from your personal meeting 
calendar. Thus, you can start and end the meeting repeatedly, without having to 
reschedule it. If you also specify that the meeting is unlisted, attendees can provide 
the same meeting number each time you restart the meeting.

On the Schedule a Meeting page, click Edit Options. Then select options under 
Regularly Scheduled Meeting.

Including a Teleconference

When scheduling a meeting, you can select one of the following teleconferencing 
options under Teleconference on the Schedule a Meeting page:

! None—Select this option if you do not need set up a teleconference—for 
example, if you want to meet with only one other attendee.

Important If you schedule a meeting without a teleconference, it is 
recommended that you clearly specify in your email invitation how you plan to 
provide audio for the meeting; otherwise, attendees may not realize that your 
meeting includes audio. For example, you can inform attendees that you will call 
them once the meeting starts. To specify this information, you can create a 
custom email invitation. For details, see “Creating a Custom Email Invitation for 
Attendees” on page 10.

! WebEx teleconferencing service—The meeting includes an integrated 
teleconference. If you select this option, select one of the following types of 
teleconferences: 
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" Attendees call in—Select this option is you want attendees to call a phone 
number to join a teleconference. Once an attendee joins a meeting that 
includes a call-in teleconference, a dialog box appears, providing the call-in 
phone number.

" Attendees receive a call back—Select this option if you want the 
teleconferencing service to call attendees to connect them to the 
teleconference. Once an attendee joins a meeting that includes a call-back 
teleconference, a dialog box appears, in which the attendee can provide his 
or her phone number. 

Important In a call-back teleconference, only meeting attendees who have 
direct phone lines can receive a call back from the teleconferencing service. If a 
receptionist answers the call from the service, or the attendee's phone system 
uses a recorded greeting for incoming calls, the attendee cannot receive a call 
back. However, an optional call-in phone number that attendees can call to join 
the teleconference is always available in the Meeting window.

! Other teleconferencing service—Select this option if you want to use a 
another teleconferencing service provider or an internal teleconferencing 
service. If select this option, you can optionally provide instructions for joining 
the teleconference in the box that appears. The instructions automatically 
appear in a message box once an attendee joins the meeting.

Including an Internet Phone Conference

When scheduling a meeting, you can choose to use Internet phone in addition to or 
instead of a teleconference. This option allows attendees to speak to each other 
using voice over IP (VOIP)—an Internet-based telephony service—rather than the 
traditional telephone system. In an Internet phone conference, only one attendee 
can speak at a time.
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To include an Internet phone conference with your meeting, under Teleconference 
on the Schedule a Meeting page, select the Internet phone check box. 

After you start the meeting, you must then start the Internet phone conference. For 
information about using Internet phone during a meeting, see “Using Internet 
Phone” on page 14.

Granting Privileges to Attendees

When scheduling a meeting, you can specify the privileges that attendee have once 
they join the meeting. To grant attendee privileges, on the Schedule a Meeting page, 
under Meeting Options, click Edit Options. Under Attendee Privileges, select the 
check boxes for the privileges that you want to grant to attendees.

Creating a Message or Greeting for Attendees

When scheduling a meeting, you can create a message or greeting for attendees 
that automatically appears in the Meeting window once an attendee joins the 
meeting. Attendees can also view the message or greeting at any time, by choosing 
Message or Greeting on the Meeting menu in the Meeting window.

Notes

! The default meeting options are ideal for most meetings. It is recommended 
that only experienced users edit meeting options.

! Once you start a meeting, the presenter can grant privileges to or remove them 
from attendees, by choosing Privileges on the Participant menu in the 
Meeting window.
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In the message or greeting, you can provide important information about the 
meeting to attendees. For example, you can provide meeting guidelines or the 
screen resolution to which attendees should set their monitors.

Creating a Custom Email Invitation for Attendees

If you invite attendees when scheduling a meeting, your meeting service 
automatically sends them invitation email messages. An invitation email message 
includes a link that an attendee can click to join the meeting. However, if you want 
to modify the automatic email message, you can initially invite only yourself to the 
meeting. Once you receive the invitation email message, you can modify it as 
needed, then forward it to attendees. In your custom invitation email message, 
ensure that you include all necessary meeting information that the original message 
contained, such as the date and time for the meeting, the meeting agenda, the URL 
for joining the meeting, and conferencing information.

Note Do not modify the meeting confirmation email message that you receive. This 
message contains information and URLs that you need to host the meeting. 

Updating Meeting Information

As a meeting host, you can update a meeting's information as follows:

1 On the navigation bar, click My Meetings.

2 On the My Scheduled Meetings page, clicking the meeting's link.

3 Click Edit.
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If you invited attendees to the meeting when scheduling it, attendees automatically 
receive an update email message whenever you update the meeting's information. 
If you invited attendees using another method, make sure that you communicate 
your updates to them. 

Note Updating a meeting does not generate a new meeting number. 
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Starting and Conducting a Meeting

This section provides information for meeting hosts, including tips and techniques 
for starting a meeting and helping attendees to join a meeting and voice 
conference.

Starting a Scheduled Meeting

Meetings do not start automatically at scheduled times. As the meeting host, you 
must first start a meeting, then attendees can join the meeting. Thus, it is 
recommended that you start a meeting about 10 minutes before its scheduled 
starting time, to accommodate any attendees who want to join a few minutes early.

Your scheduled meetings appear on the My Scheduled Meetings page, which you 
can view by clicking My Meetings on the navigation bar. If you scheduled a listed 
meeting, it also appears on the public Meeting Calendar page on your organization's 
meeting service Web site.

Helping Attendees to Find Your Meeting Service Web 
Site

If attendees have trouble finding your meeting service Web site to join a meeting, 
verify that they are using the correct URL. Some common mistakes that users make 
are the following:

! Typing www in the URL. Meeting service Web sites do not include the www server 
name. Instead, these sites include your organization's name, in the following 
format:

http://<your_organization_name>.webex.com/webex

! Typing webx instead of webex in the URL.
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! Typing http instead of https, if your site is secured with SSL (Secure Sockets 
Layer). A secure site's URL has the following format:

https://<your_organization_name>.webex.com/webex

Helping Attendees to Join a Meeting

If attendees have trouble joining a meeting, they may be attempting to join a 
meeting that you have not yet started. On the meeting calendar on your meeting 
service Web site, under Status, the text In progress and a green indicator appear 
only after you start the meeting. Otherwise, the text Not started appears.

Because a meeting’s status can change at any time, an attendee can periodically click 
the Refresh button on the page to determine whether you have started 
the meeting.

Preventing Unauthorized Access to a Meeting in 
Progress

Once all required or invited attendees have joined a meeting, you can “lock” the 
meeting by restricting access to it. Restricting access to a meeting prevents anyone 
else from joining it. To lock a meeting, choose Restrict Access on the Meeting 
menu. 
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Helping Attendees to Join a Teleconference

If your meeting includes an integrated call-in or call-back teleconference, or a third-
party teleconferencing service, instructions for joining the teleconference 
automatically appear in a message box once an attendee joins the meeting. 
Attendees can also obtain instructions for joining a teleconference at any time 
during the meeting, by choosing Join Teleconference on the Participant menu. If 
your meeting includes an integrated call-in teleconference, the call-in number also 
appears on the Info tab in the content viewer. 

Using Internet Phone

If, when scheduling or starting an instant meeting, you chose to include an Internet 
phone conference, you can start the conference at any time during the meeting, as 
follows:

On the Tools menu, point to Internet phone, then choose Start Conference.

Before starting or joining an Internet phone conference, you can use the Audio 
Tuning Wizard—which is available on the Tools menu—to ensure that your 
microphone and speakers are set to optimal levels.

For more information about using Internet phone and the Audio Tuning Wizard, 
refer to the online Help on your meeting service Web site. 
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Presenting Information

This section provides information for presenters, including tips and techniques for 
sharing presentations and applications, polling attendees, and recording meetings.

Preparing for Your Meeting

The following tips can help you to avoid problems and ensure that your meeting 
runs smoothly:

! Before you start a meeting, ensure that your computer and network are working 
properly to avoid any unexpected problems during the meeting.

! Place all the files that you intend to share in a single folder, so you can quickly 
locate them during the meeting.

! Start your meeting early, and practice sharing the documents and applications 
that you intend to share with attendees. For example, if you are sharing a slide 
presentation, display each slide in the content viewer. If you are sharing an 
application, note how quickly it appears on another computer. If there is a 
significant delay, you can troubleshoot the problem before attendees join the 
meeting.

! Ensure that you have the URL for your backup meeting site handy, in case your 
primary site is unavailable. If you do not know the URL for your backup site, ask 
your meeting service site administrator.

! Once you start a meeting, write down the meeting number, host key, and, if you 
are using the integrated teleconferencing service, the teleconference number. 
These numbers all appear on the Info tab in the content viewer.
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Using an Assistant Presenter

Using an assistant presenter is useful if you do not have a high-speed connection to 
the Internet. Although a 56K modem provides sufficient speed for sharing an 
application, it is recommended that you use a high-speed connection to the 
Internet—such as a LAN's Internet connection—to provide attendees with the best 
possible meeting experience. However, if you do not have such a connection, 
another attendee with a high-speed connection can provide presentation and 
application sharing for you. In this case, you can speak to attendees while the other 
attendee acts as an assistant presenter who “drives” the presentation, advancing 
slides and sharing applications as you need them. Having an assistant presenter also 
allows you to both focus on your speaking and view the presentation from an 
attendee's perspective.

Personalizing Your Meeting with Video

You can use video to introduce yourself at the beginning of a meeting, if you 
attached a video camera to your computer, and your meeting service provides the 
video option. To send live video to attendees, simply click the Video tab.

Providing Interactivity

When sharing a presentation, use the annotation tools to highlight text or graphics, 
emphasize points, and draw and write notes. If you are conducting a meeting with 
few attendees, allow attendees to annotate your presentation. Attendees can use 
annotation tools, for example, to point to areas on a slide about which they want to 
comment or ask a question.
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Choosing an Option for Sharing Presentations or 
Documents

Your meeting service provides the following options for sharing a presentation or 
document: 

! Sharing a presentation or document in the content viewer—Choosing the 
Presentation or Document option on the Share menu displays the 
presentation or document in the content viewer. If you used Microsoft 
PowerPoint to create your slides, the content viewer also displays any 
animations and transitions that you have added to the slides. The presentation 
or document sharing option provides you with a set of annotation tools that 
both you and attendees can use; viewing options, such as thumbnails and full-
screen view; and simultaneous use of the entire Meeting window, including chat 
and video. 

! Sharing a presentation as an application—Instead of displaying a 
presentation or document in the content viewer, you can open the presentation 
or document in the application with which it was created, then share the 
application. Sharing a presentation as an application allows you or an attendee 
to edit the slides during the meeting. However, while you are sharing an 
application, the Meeting window is not available, including the toolbar, chat, 
video, and so on. 

! Sharing a presentation or document by sharing your desktop—Sharing your 
desktop provides the same benefits as sharing your presentation as an 
application. However, desktop sharing allows you to quickly display additional 
applications that you want to share with attendees.
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Choosing an Option for Sharing Web Pages

During a meeting, you can display Web pages to attendees in either of two ways:

! Web browser sharing—Web browser sharing allows you to take attendees on 
a “Web tour.” Attendees can view each Web page that you access, either on the 
Internet or on your organization’s private intranet. You can optionally allow 
attendees to control your Web browser. This option uses more bandwidth than 
the following two options.

! Web content sharing—To share a Web page on the Internet that includes 
multimedia effects, such as sound and animation, you can use Web content 
sharing. This option allows you to specify a URL for a Web page, which opens in 
a Web browser window on each attendee’s computer. Attendees can hear 
sounds an interact with other multimedia effects independently in their 
browsers. This option also allows you to share a single Web page faster than you 
can using the Web browser sharing option; however, it does not allow you to 
guide attendees to other Web pages.

! Presentation sharing—Using the WebEx Universal Communications Toolkit, 
you can insert a link to a Web page directly in a Microsoft PowerPoint 
presentation. When you share the presentation in the content viewer during a 
meeting, using the Presentation or Document command on the Share menu, 
the Web page appears on the slide on which you inserted it. This option is best 
if you do not want to stop your presentation to use either Web browser sharing 
or Web content sharing. For more information about creating and sharing 
presentations in which you insert media, see “Using UCF Multimedia to Enhance 
Your Presentation” on page 23.
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Sharing HTML Files on Your Computer

To share an HTML file that resides on your computer, you can use Web browser 
sharing, instead of application sharing. Simply share your Web browser, choose 
Open on your browser’s File menu, then select the file on your computer.

Sharing a Presentation Before a Meeting

To save time during a meeting, begin sharing a document or presentation before the 
meeting's starting time. That way, once attendees join the meeting, they can begin 
viewing your presentation.

Letting Attendees Print Handouts

You can let attendees print handouts at any time during a meeting, as follows:

1 Share the handout by choosing Presentation or Document on the Share 
menu.

The handout appears in the content viewer.

2 On the Participant menu, choose Privileges.

3 In the Attendee Privileges dialog box, select the Print check box, then click 
Assign.

Attendees can now print the shared handout by pointing to Print on the File menu, 
then choosing Document.
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Synchronizing Displays

When you share a document or presentation in the content viewer, some attendees’ 
viewers may set to different magnifications. Thus, some attendees may not be able 
to view the entire page or slide that you are sharing. To resolve this problem, simply 
click the Synchronize button on the toolbar.

All attendees’ content viewers then display the page or slide at the same 
magnification that you set in your viewer.

Improving the Performance of Document or 
Presentation Sharing

You can improve the speed at which shared pages or slides appear to attendees by 
doing any of the following: 

! Before attendees join the meeting, save the document or presentation as a .ucf 
(Universal Communications Format) file, then share the .ucf file, as follows:

1 Share the document or presentation.

2 On the File menu, choose Save.

3 Save the document or presentation as a .ucf file on your computer.

4 On the Share menu, choose Share Presentation or Document.

5 Select the .ucf file that you saved.

! Limit the number of animations and slide transitions that you add to Microsoft 
PowerPoint slides.
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! Minimize the number of screen shots that you add to slides, especially if they are 
bitmap graphics. Such graphics do not compress well.

! Do not include more than 20 to 30 slides in one presentation file. If you want to 
share more slides, create a separate presentation file for each set of 20 to 30 
slides.

! Keep the size of the presentation file to no more than 5 MB.

Performing Animations and Slide Transitions

When sharing a Microsoft PowerPoint slide presentation in the content viewer, you 
can perform animations on the slides and slide transitions, by importing the 
presentation using the Universal Communications Format (UCF) import mode. The 
UCF import mode is the default mode. To ensure that you import your presentation 
in the UCF mode, on the Meeting menu, choose Options, then click the Import 
Mode tab.

Once you begin sharing a presentation, you can perform slide transitions or 
animations, as follows:

1 Click in the content viewer to set the input focus. A blue border around the 
shared slide indicates that the viewer has input focus.

2 Do either of the following:

! To perform the next slide transition or animation, click the Next button on the 
toolbar. 
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! To perform the previous slide transition or animation, click the Previous 
button on the toolbar.

You can also use the keys on your keyboard to perform slide transitions or 
animations, or to navigate your slides:

To... Press...

Display the next slide or perform the next 
animation or slide transition

Space Bar, Page Down, Right 
Arrow, or Down Arrow

Display the previous slide or perform the 
previous animation or slide transition

Page Up, Left Arrow, or Up 
Arrow

Display the first slide Home

Display the last slide End
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Using UCF Multimedia to Enhance Your Presentation

During an online meeting, you can share the following types of media files in the 
content viewer to make your presentation more engaging and impressive:

! WebEx Recording Format (WRF) files

! video files

! audio files

! Flash movie and interactive Flash files

! Web pages

To share a media file, you must use a Universal Communications Format (UCF) media 
object. A media object links to the media file and provides a window in which the file 
appears. An object also contains options and controls for displaying or manipulating 
the file.

You can share media files in either of two ways:

! In a Microsoft PowerPoint presentation—Using the WebEx Universal 
Communications Toolkit, a plug-in for Microsoft PowerPoint, you can insert UCF 
objects into your slides. You can then share the presentation during a meeting.

You can download the Universal Communications Toolkit from the Support 
page on your meeting service Web site.

! As a standalone file—You can share a media file directly in the content viewer. 
Meeting Manager creates a UCF object for the file automatically, which appears 
in the content viewer.

For more information about creating UCF multimedia presentations, refer to 
Getting Started with WebEx Universal Communications Toolkit. For more 
information about sharing either a UCF multimedia presentation or a 
standalone media file, refer to the online Help on your meeting service Web site.



Presenting Information
24
Sharing Graphics Quickly

You can quickly share a graphics file with attendees by copying it to your computer's 
clipboard, then pasting it in the content viewer. To copy an image, do one of 
the following:

! Right-click an image on a Web page or in a document, then choose Copy.

! Capture your entire desktop to an image by pressing and holding down the Alt 
key, then pressing the Print Screen key.

Once you copy an image to your computer's clipboard, on the Edit menu in the 
Meeting window, choose Paste Page Image.

You can paste any bitmap image in the content viewer, such as a GIF, JPEG, BMP, or 
TIF image. You cannot paste other types of images—such as EPS or Adobe 
Photoshop (PSD) images—in the content viewer.

Ensuring That Your Slides Are in Color

When sharing Microsoft PowerPoint slides, you may find that your slides appear in 
black and white or grayscale in the content viewer. Because your meeting client 
software uses a printer driver to display your slides, this problem may occur if 
PowerPoint is set to print in black and white or grayscale. To display your slides in 
color, you must turn off the option to print in black and white or grayscale in 
PowerPoint. For instructions on turning off this option, refer to PowerPoint Help.

Optimizing Attendees' Shared Views

The following tips can help you to avoid common problems with application, Web 
browser, or desktop sharing:
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! Differences in screen resolution settings between your computer and an 
attendee's computer may prevent an attendee from viewing the entire 
application, Web browser, or desktop that you are sharing. To help avoid this 
problem, set your monitor to a lower screen resolution, such as 800 by 600 
pixels. If an attendee's view of shared software is too small, request the attendee 
to set his or her computer's screen resolution to 800 by 600 pixels. 

For instructions on setting screen resolution, refer to your operating system's 
online help.

! You can also resolve some problems with screen resolution by choosing the 
Show Full-Screen View for Attendees on the Sharing menu, which appears in 
the title bar of the application or Web browser that you are sharing.

! To improve the quality of attendees' views of a shared application, ensure that 
your screen display and attendees' screen displays are set to the same color 
depth—for example, 16-bit color. 

For instructions on setting screen color depth, refer to your operating system's 
online Help.

Communicating Your Monitor Settings to Attendees

To optimize application, Web browser, or desktop sharing, you and attendees should 
set your monitors to the same screen resolution and color depth (see “Optimizing 
Attendees' Shared Views” on page 24). As a presenter, you can specify the screen 
resolution or color depth to which attendees should set their monitors in the 
following ways:

! Once you start a meeting, specify monitor settings in a chat message to all 
attendees. Remember to resend the message often, because attendees cannot 
view any chat messages that you send before they join a meeting. 



Presenting Information
26
! Specify monitor settings on either the first slide of your presentation or in the 
header on each slide.

! Specify monitor settings by typing them on a shared whiteboard.

Note A meeting host can specify monitor settings for attendees in a message or 
greeting that automatically appears in attendees’ Meeting windows. For details, see 
“Creating a Message or Greeting for Attendees” on page 9.

Opening Applications Before a Meeting Starts

To save time during a meeting, begin sharing one or more applications before the 
meeting's starting time, then minimize their windows. At the appropriate time 
during the meeting, you can quickly begin sharing an application by restoring its 
window, without waiting for the application to start.

Improving the Performance of Software Sharing

To improve the performance of software sharing, do the following:

! Close all applications that you do not need to use or share on your computer. 
Doing so conserves processor usage and memory on your computer, thus 
helping to ensure that Meeting Manager can send images of shared software 
quickly during a meeting.

! To ensure that the maximum amount of bandwidth is available for software 
sharing, close any applications on your computer that use bandwidth, such as 
instant messaging or chat programs, and programs that receive streaming audio 
or video from the Web.
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! Ensure that the Meeting Manager display mode is set optimally for the 
application that you are sharing. You can choose one of two display modes: one 
for normal applications and another for graphics-intensive applications. To set 
the display mode, on the Meeting menu, choose Options.

Avoiding Blocked Views

If you cover a shared application or Web browser with another window on your 
computer's desktop, attendees cannot view the area of the application or browser 
that the other window covers. Instead, a crosshatched pattern appears in the 
covered area on attendees' screens. To help to avoid this problem, ensure that you 
minimize all applications that are running on your computer, then restore the 
window for only the application or browser that you want to share. 

To ensure that you do not block a shared view and create the crosshatched pattern, 
use a second computer to join the meeting as an attendee and monitor the 
attendees' view of your presentation.

Transmitting Sound While Sharing Applications or Web 
Pages

During a meeting, you can transmit sound that shared applications or Web pages 
play, as follows:

! Applications that play sound—To transmit sound that a shared application 
plays, first start an Internet phone conference. If you are not the host, the host 
must start the Internet phone conference and then pass the microphone to you. 
Next, place your microphone next to one of your computer’s speakers. Once 
attendees join the Internet phone conference, they can hear the sound through 
their computers’ speakers. If your meeting also includes a teleconference, you 
can continue the teleconference normally. 
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For more information about using Internet phone, see the online Help on your 
meeting service Web site.

! Web pages that play sound—To transmit sound that a Web page plays, use the 
Web Content option on the Sharing menu, instead of Web browser sharing. 
This option allows you to specify a URL for a Web page, which opens in a new 
Web browser window on each attendee’s computer. Attendees can hear sounds 
an interact with other multimedia effects independently in their browsers.

Using Two Web Browsers for Training

When training other users to use your meeting service, you can allow attendees to 
see your view of the Meeting window—that is, the presenter's or host's view—to 
show them how to schedule and start meetings and use host and presenter options. 
To do so, use two different Web browsers—for example, Microsoft Internet Explorer 
and Netscape Navigator—to provide attendees with a view from a host's or 
presenter's perspective. Use one browser to start a meeting. Then use application 
sharing to share the other browser, in which you demonstrate how to use the 
meeting service Web site and use Meeting window options.

Training Attendees on Using Applications

If you train attendees on how to install and use an application, you can use the file 
transfer option to allow attendees to download the application's installation 
program. Then, you can use desktop sharing to help each attendee install the 
software or troubleshoot any problems that they encounter.

Speeding Up Polling

To save time, you can prepare a questionnaire before a meeting's starting time, save 
it, then open it for use during the meeting.
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If each question in your poll has the same set of answers from which attendees can 
choose, you can do the following to take the poll more quickly and efficiently:

1 Create a slide for each question, using presentation software, such as Microsoft 
PowerPoint. 

2 Use the Polling tab to create one set of answers that applies to the questions on 
all the slides. 

3 When taking the poll, display a polling slide in the content viewer.

4 On the Polling tab, open the poll to allow attendees to choose an answer to the 
question on the slide, then close the poll. 

5 Repeat the process for each polling slide.

Providing Poll Questionnaires and Results to Attendees

If you take a poll during a meeting, attendees normally cannot save the poll 
questionnaire or results files to their computers. However, if you want to provide 
these files to attendees, you can choose File Transfer on the File menu, then select 
the poll questionnaire or results files. Attendees can open a poll results file using any 
text editor. Attendees who act as presenters in subsequent meetings can open a 
questionnaire file in the Meeting window, and it will appear on the Polling tab.

Recording Meetings for Remote Teams

If you want to give a presentation to a remote team in another time zone, you can 
record a meeting—including all interactions, sharing, and audio—using WebEx 
Recorder. You can then publish the recording on your Web site. Members of the 
remote team can use WebEx Player to replay the meeting at any time.
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WebEx Recorder is integrated in the Meeting window. WebEx Player and a 
standalone version of WebEx Recorder are available on your meeting service Web 
site. Instructions for publishing a recording are also available on your site.
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Hosting a Large Meeting

This section tips and techniques that can help you to host a large meeting, or 
“webinar,” more effectively.

Muting Audio

If you are using an integrated WebEx teleconferencing service, you can prevent 
distracting noises during a meeting by muting the audio for all attendees who are 
participating in a teleconference. To do so, on the Participant menu in the Meeting 
window, choose Mute All.

Using Two Computers

If you are the presenter for a meeting with a large number of attendees, you can 
monitor the attendees' view of the meeting by using two computers. Use one 
computer to present information, and use the other computer to view the meeting 
as an attendee.

Setting Up a Dual-Mode Voice Conference

If your meeting requires only one-way audio—that is, a meeting in which attendees 
listen to the presenter but do not speak themselves—you can set up a dual-mode 
voice conference. A dual-mode voice conference includes both a teleconference and 
an Internet phone conference. Attendees can choose to listen to audio using either 
their phones or speakers attached to their computers. For example, if joining the 
teleconference would require an attendee to make a long-distance call, the 
attendee could use Internet phone instead.

To set up a dual-mode voice conference, do the following:
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1 On the Schedule a Meeting page, set up a teleconference using either the 
integrated WebEx teleconferencing service or a third-party teleconferencing 
service. 

2 Select the Internet phone check box.

3 Once you start the meeting, start an Internet phone conference. For details, see 
“Using Internet Phone” on page 14.

To allow all attendees to hear audio, the presenter must speak into both a phone and 
a microphone attached to his or her computer. 

For detailed information about setting up an integrated teleconference and 
starting an Internet phone conference, refer to the online Help on your meeting 
service Web site.

Providing Technical Support

Provide attendees with a phone number that they can call to receive support from 
your technical personnel. Having this phone line available helps to ensure that all 
attendees can fully participate in a meeting. 

To avoid having attendees interrupt a meeting when they need help, provide your 
support number on the first slide in the content viewer, or in the header of each 
slide; or in a message or greeting. If your staff is unable to resolve an issue, attendees 
can call WebEx Technical Support at 408-435-7088 or toll-free at 1-866-229-3239.
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Establishing Meeting Guidelines

To help keep a large meeting running smoothly, you can provide attendees with a 
list of meeting guidelines to follow. For example, you can specify how and when 
attendees can ask questions, request annotation control, request remote control, 
and so on. To provide your guidelines to attendees, you can do either of the 
following:

! When scheduling a meeting, create a message or greeting in which you specify 
your guidelines. The message or greeting automatically appears once an 
attendee joins the meeting. Attendees can view the message or greeting at any 
time, by choosing Message or Greeting on the Meeting menu in the Meeting 
window.

! Include your guidelines on the first slide in your presentation. Once attendees 
join a meeting, they can read the guidelines before you start your presentation

Designating a Chat Moderator

Chat provides a convenient way for attendees to ask questions during a meeting. To 
ensure that attendees receive timely answers to their questions, and to avoid 
interrupting the meeting, you can designate another attendee as a chat moderator. 
The moderator can answer attendees' questions by sending public or private chat 
messages to them. At the beginning of the meeting, instruct attendees to use chat 
to ask questions and to direct their questions to the chat moderator.

Handling Disruptive Attendees

To prevent a disruptive attendee from taking control away from the presenter, be 
careful when granting privileges to attendees. If an attendee continues to disrupt a 
meeting, you can expel the attendee by selecting the attendee’s name on the 
Participants tab, then choosing Expel on the Participant menu.
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Once you expel an attendee, you can prevent the attendee from attempting to 
rejoin the meeting by choosing Restrict Access on the Meeting menu.
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Solving and Avoiding Common Problems

This following are tips for solving and avoiding some common problems that you 
may encounter when using your meeting service.

Using a Dial-Up Connection

Attendees who use dial-up connections to the Internet can avoid unnecessary 
delays in screen updates during a meeting by connecting to their local ISPs, rather 
than to their corporate servers. Connecting to a corporate server can cause delays in 
receiving meeting data because the data must traverse a longer path, and thus is 
more likely to traverse congested lines.

Testing Dial-Up and High-Speed Connections

If you use a dial-up connection, poor phone lines and equipment in your area may 
affect your meeting experience. If you suspect that such a problem exists in your 
area, contact your phone service provider.

Even if you use a high-speed connection—such as ISDN, DSL, T1, or T3—you may 
experience bandwidth limitations or data loss. These problems may originate with 
your ISP or a major hosting facility in your area. For example, some ISPs use proxy 
servers to handle inbound and outbound network traffic. These servers can reduce 
your connection speed and thus affect the performance of your meeting service.

To determine the speed of your connection and whether any problems exist with 
your connection, you can use traceroute—a utility that records the route 
that data traverses on the Internet between your computer and a specified 
destination computer. 



Solving and Avoiding Common Problems
36
To use traceroute on a Windows computer to test the connection between your 
computer and the computer that hosts your meeting service Web site, follow 
these steps:

1 On the Start menu, point to Programs, then choose MS-DOS Prompt.

In the MS-DOS Prompt window, type your meeting service Web site’s URL, which 
has the following format:

tracert <your_organization_name>.webex.com/webex

where <your_organization_name> is the name of your organization.

2 Press Enter.

The traceroute results indicate how many hops—or routers—that data must 
traverse to reach your meeting service Web site, and the time it takes for data to 
reach your site, in milliseconds (ms). On a good connection, data takes between 15 
to 100 ms to reach its destination. If the data's travel time is longer than 100 ms, your 
connection is slow. In this case, examine the results to determine where the data's 
path became slow. You can help to isolate a problem by tracing the route to a well-
known Web site, such as www.yahoo.com, and comparing the results to those for 
the route to your site.
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Clearing Your Web Browser's Cache

Clearing your Web browser's cache can improve its performance, and thereby your 
meeting experience. To clear you browser's cache, follow these steps:

Internet Explorer 4.x

1 On the View menu, choose Internet Options. 

2 Under Temporary Internet files, click Delete Files.

Internet Explorer 5.x

1 On the Tools menu, choose Internet Options. 

2 Under Temporary Internet files, click Delete Files.

Netscape Navigator

1 On the Edit menu, choose Preferences. 

2 Expand Advanced.

3 Select Cache.

4 Click Clear Disk Cache.

Handling Firewall Problems

Your meeting service Web site sends and receives all meeting data through port 
80—your firewall's standard HTTP port. You need not open any other ports on 
your firewall.
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If port 80 is open on your firewall but you still cannot use your meeting service Web 
site, please contact WebEx Technical Support at 408-435-7088 or toll-free at 1-866-
229-3239.

Using a Proxy Server

If your computer uses a proxy server to connect to the Internet, you can access your 
meeting service Web site through the server. However, if the proxy server caches 
pages that you access on your meeting service Web site or uses an additional 
authentication process for Internet access, you may be unable log in to your site, 
start or join meetings, or navigate your site. To resolve this problem, ask your 
network administrator to configure a proxy server exception for your primary and 
backup meeting service Web sites.
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